
Machining Tutorial 

DFMA® Should Costing Software 1 Boothroyd Dewhurst, Inc. 

DFMA® Should Costing Software 
Machining Tutorial 
 

Machining is the process of removing material from a workpiece. This is a common process for 

creating parts, especially metal parts.  Machine tool setups hold a cutting tool or abrasive 

wheel, hold the workpiece, and then provide for relative motion between the two in order to 

produce the desired surface.  

The DFMA Should Costing software can be used to model the secondary machining of parts that 

are formed by another process as well as the machining of parts directly from a stock shape of 

material.  The following tutorial shows the two different methods that can be used to model a 

part machined completely from stock. 

Parts machined from stock can be analyzed in the program in two distinctly different ways, by 

using the Dynamic Cost Agent or not.  When the Dynamic Cost Agent is not used, the analysis is 

based on the definition of individual machine tool setups and the individual machining 

operations that are performed on each setup.  When the Dynamic Cost Agent is used it is not 

necessary to define the individual machine tool setups and machining operations.  Instead, the 

overall shape of the part is classified and various types of part features are defined.  The 

program uses that information to automatically determine a suitable machining process as well 

as the resulting part cost.  With the Dynamic Cost Agent, there is also an option to determine 

the most important cost drivers for your specific part which makes the machining analysis 

easier and faster to complete. 

The first part of this tutorial will guide you through a machining analysis while using the 

Dynamic Cost Agent and the second part of this tutorial will cover a machining analysis without 

using the Dynamic Cost Agent. 

The part analyzed in this tutorial is a hollow cylinder base that is cut from bar stock and then 

has various machining operations performed on it using a turning center.  A dimensioned 

drawing of this part is shown on the next page and the completed DFMA Should Costing 

analyses are contained in the sample file cylinder.dfmx that has been included with your 

installation of the software (\data\samples). 
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Part 1 - Analysis of a machined part with the Dynamic Cost Agent 
Begin the analysis 

1. In a new analysis, complete the part description as shown here: 

 

2. Accept the default forming direction shown above because this is the direction in which the 

bar stock would have been produced. 

3. Double-click the Original name on the tab above the Process Chart. Type Dynamic Cost 

Agent and press the Enter key. 

4. Click the Select process and material button. 

5. On the left side of the Process and Material selection window choose Machining or cut from 

stock for the process.  On the right side of the window, expand the Stainless steel material 

category and choose Generic stainless steel.  In the middle, be sure the 25B BDI United 

States manufacturing profile is selected. 

6. Click OK to return to the main window with the responses for the Stock process entry 

displayed on the right panel.   
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7. Note that the stock material form is defaulted to round tube because the hollow cylinder 

part envelope shape was chosen at the beginning of the analysis.  This part will actually be 

machined from solid bar, so select Round bar or rod for the stock material form. Click 

Calculate in the Cost results box. 

8. Leave the cutoff method set to Abrasive cutoff.  The default values for material cost and 

scrap value come from the material library and any edits made here to these defaults apply 

only within this analysis of the part. 

9. When a machined part is analyzed with the Dynamic Cost Agent, the Volume and Weight 

displayed in the Part geometry section are used to estimate the amount of material 

removed during machining and they affect the software’s estimate of the rough machining 

time required.  For this analysis, we know the volume of the finished cylinder so change the 

Volume to 20.74 and click Calculate to update the Weight field and cost results. 

 

10. Click the Workpiece entry on the Process Chart and then review the responses on the right 

panel.  Here, the fields that affect workpiece cost and volume prior to machining are 

recorded. 

11. Click the Abrasive cutoff entry on the Process Chart and then review the responses on the 

right panel.  For this analysis, we accept these default values which include the hourly rates 

and setup time for the cutoff operation. 
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12. Click the Insert menu at the top of the window and then click Dynamic Cost Agent 

Machining. 

 

The Machining operations entry is added to the Process Chart and a default cost estimate 

for machining the part has been generated by the program.  This default machining cost 

estimate will now be refined to make it more accurate.  

13. The cylinder is a turned part with drilled and tapped holes in its flange as well as milled 

grooves in its body.  These part features require live tooling on the lathe during machining 

which means the part should be classified as a rotational part with secondary features.  For 

that reason, click the Primary rotational & secondary button.  The response panel updates, 

as shown on the following page. 
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14. At the top of the response panel, click OFF to turn off the Dynamic Cost Agent.  Note that 

the Dynamic Cost Agent lightning bolt becomes hollow and the response panel updates to 

display all the inputs needed to completely describe a rotational part with secondary 

features, as shown on the following page. 
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15. Click ON to turn the Dynamic Cost Agent back on and note that a much smaller list of inputs 

is displayed, as shown below.  This list reflects the most important cost drivers for the 

analyzed part, and it will vary depending on the conditions defined in the analysis.  Focusing 

your analysis on these inputs minimizes the time and effort required to analyze a part while 

also minimizing errors in the accuracy of the cost results.   
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16. Finish turning of the cylinder is carried out on the outside and inside faces of the large 

flange, the outside face of the small flange, and the central bore. For these features, enter 

4 into the Finish machined turned features input.  Click Calculate to update the response 

panel and note that the important inputs displayed remain unchanged. 

17. Enter 4 for the Drilled secondary holes input to account for the four secondary holes that 

are drilled into the large flange.  Click Calculate to update the response panel and note the 

additional important inputs displayed, as shown below. 
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18. Return to the top of the input list and specify the Rough turned features input.  Rough 

turning is done down to the outer diameter of the small flange all the way to the inside face 

of the large flange.  Rough turning is also done down to the middle diameter of the part 

between the inside faces of the large and small flanges.  The primary hole rough drilled 

through the center of the part, prior to finish boring, is also classified as a rough turned 

feature because it is made using the lathe main spindle.  For these features, enter 3 into the 

Rough turned features input.  Click Calculate to update the response panel and note the 

number of important inputs displayed has been reduced substantially, as shown below. 

 

19. The cylinder has no finish machined planar features so it is unnecessary to modify the zero 

default value for that input.  There are also no ground rotational or planar features on the 

part and no broached or gear features which means the zero default values for those inputs 

apply.  The machining analysis of the cylinder using the Dynamic Cost Agent to identify the 

most important cost drivers is now complete. 
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20. Click the top-level of the process chart and note that the total cost result is $49.8125 per 

part. 

Part 2 - Analysis of a machined part without the Dynamic Cost Agent 

In the second part of this tutorial, a copy of this analysis will be used to analyze the same part 

without the Dynamic Cost Agent and then the cost results will be compared.  

21. Click the Dynamic Cost Agent analysis tab at the top of the Process Chart.  Click the Edit 

menu at the top of the window and then click Copy.  Click the Edit menu at the top of the 

window again and then click Paste to create a copy of the analysis tab. 

22. Double-click the rightmost Dynamic Cost Agent analysis tab and change its name to No 

Dynamic Cost Agent. 

23. Delete the Machining operations entry from the Process Chart. 

Adding a machine tool setup 

24. Add a machine tool setup.  Click the Insert menu at the top of the program window and 

then click Machine Tool Setup on the menu.  In the dialog that opens, expand the Lathes 

category, if necessary.  Click the Shenyang HTC2050im CNC Lathe machine. 

25. Click the Insert button to add the machine to the Process Chart. 

26. Close the Insert machine dialog and view the responses for the lathe. 

27. Note that the batch size and the material hardness can both be changed for individual 

setups. For this analysis we will accept the default values. 

28. Also note that the Rejects, % input appears in the Basic data group box. This is the 

percentage of parts rejected after all operations on the setup have been completed.  The 

cost allocated to each acceptable part because of these rejected parts is shown in the Cost 

results panel, underneath the Process Chart. 

29. Note the Result box on the Responses Panel where the total cycle time and the total setup 

time are both displayed for the setup. These will be recalculated and updated as machining 

operations are added to the setup. 

30. Click the Setup/load/unload Process Chart entry that appears beneath the machine and 

review the responses on the right panel.  Here, the hourly rate and the time required to set 

up the machine tool can be specified along with the cost of any required fixtures or 

programming. 
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31. In the Work handling box, choose 3-jaw chuck from the Workholding device dropdown list. 

Change the Number of reversals to 1 because the part must be reversed in the chuck and 

machined from both ends.  Click the Calculate button to update the Responses Panel and 

the Cost results. 

 

32. Add machining operations to the setup. With the Setup/load/unload operation selected on 

the Process Chart, Choose Operation from the Insert menu to open the Insert Operation 

dialog. 

33. Expand the Machining category and then the Drilling subcategory. Highlight the Drill single 

hole operation and click the Insert button to add it to the machine.  Close the Insert 

Operation dialog. 

34. The Responses Panel shows a picture of the drilling operation with appropriate dimensions 

labeled to simplify the specification of cut dimensions. Results are not calculated until the 

dimensions have been entered. 
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35. Enter 1.5 inches for the Diameter of drilled hole (dh) and 6 inches for the Length of drilled 

hole (lh). Change the tool material selection to Carbide. See that the box remains checked to 

include the tool replacement cost. 

36. Click the Calculate button to update the Cost per part results.  The Responses Panel for the 

operation appears as shown below. 

 

Note that the Maximum power required and the Maximum spindle speed required are both 

below the available values on the selected machine.  This indicates the drilling operation is not 

limited by the machine and will be carried out at optimal machining conditions. 

The special tooling cost input is used to specify the cost of any special fixtures or other special 

tooling that is not included elsewhere. 

The Operation time result includes the time to position and change the tool whenever 

necessary.  Default values for the tool positioning time and the tool change time are available in 

the responses for the machine tool. 

The remaining machining operations would now be added to the analysis in the very same way 

until all of the machining required to produce the part has been described.   
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View the completed sample analysis 

37. Click the File menu at the top of the program window and then click Open.  In the Open 

dialog, navigate to the \data\sample folder if necessary and open the cylinder.dfmx analysis 

file. 

38. The leftmost analysis tab in this sample file contains the machining analysis that was 

completed during the first part of this tutorial using the Dynamic Cost Agent.  The rightmost 

analysis tab contains a completed version of the analysis started in the second part of this 

tutorial without the Dynamic Cost Agent and with all the individual machining operations 

defined. 

39. Click the Results menu at the top of the program window and then click Cost Totals to 

display the graph.  Click the   toolbar button to display the Pie chart and then, on the 

right side of the graph window, check the boxes to compare both analyses, as shown below. 

 

Discussion of results  

The most detailed and accurate cost estimate is achieved from the analysis completed with no 

Dynamic Cost Agent where each individual machining operation has been defined and each 

movement of the cutting tool has been accounted for.  The analysis done with no Dynamic Cost 
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Agent also provides a very detailed breakdown of machining costs so the cost of each individual 

part feature can be estimated and examined.  The total cost per part result shown on the graph 

for this analysis is $50.3587. 

In the analysis that used the Dynamic Cost Agent, the program automatically made a tradeoff 

between the time and effort required to analyze the part and the accuracy of the cost results.  

For this part, the analysis done with the Dynamic Cost Agent has resulted in a cost estimate of 

$49.8125.   

40. Mouse over the gray Difference pie piece and note that a pop-up message displays to 

indicate the error in the analysis that used the Dynamic Cost Agent is -0.5462, or roughly 

1.08%.  The magnitude of this error, on a percentage basis, is typical for an analysis 

completed while using the Dynamic Cost Agent. 

41. Click the  toolbar button to display the comparison bar chart, as shown below.  This 

graph enables an easier comparison of the individual cost results for the two analyses. 

 

As you can see from the graph, the two analyses have the same material cost result.  This is 

because the part material cost is estimated in the same way regardless of the type of analysis 

done.  In this case, more than 74% of the part cost is due to the cost of the part material.  This 

means nearly 3/4 of the estimated cost does not depend on the type of analysis done and the 

approximations made while using the Dynamic Cost Agent have only affected 1/4 of the cost 
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estimate.  This is typical, and for most machined parts the cost of material makes up more than 

half the part cost.  This is one reason why using the Dynamic Cost Agent has a negligibly small 

impact on the overall cost results for machined parts.  And this means the benefit of the 

substantially reduced effort needed to complete the analysis of a machined part can be realized 

by using the Dynamic Cost Agent without substantively affecting the overall cost results. 

The setup and rejects costs are both very small, which means the impact of the Dynamic Cost 

Agent approximations on these results are also very small.  With the Dynamic Cost Agent, the 

setup cost was overestimated by $0.0747, and the rejects cost was also overestimated by 

$0.015.  This shows that the Dynamic Cost Agent approximations in these costs have 

contributed to a difference of less than nine cents, or 0.18%, in the overall estimate of part cost 

and most of that difference was due to approximations in the estimate of setup cost.  This is 

typical for machined parts that are produced in medium to high production volumes and in 

these cases the Dynamic Cost Agent approximations will result in very small errors in the setup 

cost per part. 

With the Dynamic Cost Agent the process cost has been underestimated by $0.6359, which 

accounts for most of the cost difference between the two analyses.  This difference is primarily 

due to the way the machining non-productive time has been estimated by the program.  When 

the Dynamic Cost Agent is not used, each movement of the cutting tool has been defined 

directly and has been accounted for in the time and cost results generated by the program.  

However, when the Dynamic Cost Agent is used to analyze a machined part, the program 

automatically estimates the number of cutting tool movements required, and in this case, the 

program has underestimated the value.  The impact of this non-productive time on the 

machining cost results tends to become larger for machined parts that are smaller in size.  This 

means the approximations used by the Dynamic Cost Agent will yield reasonable results for all 

but the tiniest of machined parts and the estimates produced while using the Dynamic Cost 

Agent tend to improve as machined parts increase in size. 
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